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Dear customer,

Thank you for choosing Anycubic products.

Maybe you are familiar with 3D printing technology or have purchased
Anycubic printers before. However, we still highly recommend you read this

manual carefully, as the installation techniques and precautions can help you
avoid any unnecessary damage or frustration.

Please visit https://support.anycubic.com to contact us if you have any

questions. You can also learn more information from the website, such as

software, videos, models.

e

Anycubic support center

Copyrighted by “Shenzhen Anycubic Technology Co., Ltd ”, all rights reserved.

Team Anycubic


https://support.anycubic.com/

Safety Instructions

Always follow the safety instructions during assembly and usage, to avoid

unnecessary damage to the 3D printer or individual injury.

FC CERoHS & & &

Please contact our Customer Service if you have any issues after
receving the products.

In case of emergency, please immediately cut off the power of the
3D printer and contact our technical support.

UV light is harmful to the eyes; please avoid direct contact. When
operating, wear protective equipment such as anti-UV goggles and
gloves.

Anycubic 3D printer includes components that can cause injury.

Be cautious when using the scraper, and make sure to orient the
sharp parts of machine and tool away from people.

Keep the Anycubic 3D printer and its accessories out of the reach of
children.

Vapors or fumes may be irritating at operating temperatures.
Always use the Anycubic 3D printer in an open and well ventilated
area.

Do not expose Anycubic 3D printer to any water or rain
environment.

Use Anycubic 3D printer in an environment with a temperature of
8°C-40°C and a humidity of 20%-50%. For optimal performance, do
not exceed this range. Also, avoid direct sunlight exposure.

Do not disassemble Anycubic 3D printer, please contact technical
support if you have any questions.

FCC-ID: 2AXYKM5SPRO
UK CMIITID:2023DP7654 (M)
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Product Overview
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Product Overview

Air Heat & Pure

ANYCUBIC
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In the Box

ANYCUBIC ﬂ
==
L
[ ]
Photon Mono Print platform * 1 Resinvat * 1 Air Heat & Pure kit
M5s Pro
117 < T
Hex key set Protective equipment Funnel*5 Scraper * 2
instalationand VAR oLt
USB pepsisectons M Leveling Paper
USB drive * 1 Manual * 1 Screen protector kit  Leveling Paper

Power cord
Power adaptor



Technical Specification

Operating System

System Photon Mono M5s Pro
Touch Screen 4.3-inch Resistive Screen
Software Anycubic Photon Workshop

(also compatible with other software)

Connectivity USB Drive, WIFI

Specifications

LCD screen 10.1 inch 14K
Light source Matrix LED light
XY Resolution 13312 %5120

Z axis Accuracy 0.01T mm
Suggested Layer Thickness 0.01 ~0.15 mm

Physical Dimensions

Dimension 290 mm(L) *270 mm(W) *460 mm(H)

Build volume 223.78 mm(L) *126.38 mm(W) *200 mm(H)
Weight 9.4 kg

WiFi

Frequency Range 2.4 G (2.400~2.4835 GHz)

Work Mode AP, STA, AP+STA mode



Technical Specification

Air Heat & Pure

Control method Button

Input voltage 24V

Rated power 55w

Range of temperature 20~40°C

Dimension 55 mm(L) *73 mm(W) *178 mm(H)
Carbon size 39 mm(L) *39 mm(W) *18 mm(H)
Weight 284 g



Recommended Print Parameters

Parameters @ Default (2 Default 3 High Speed
Group Resin_Normal Resin_Fast Resin
Layer Thickness 0.05 mm 0.1 mm 0.1 mm
Normal Exposure 365 38¢ 195
Time
Off Time 0.5s
Bottom Exposure 30s 305 10's
Time
Bottom Layers 5 4 3
Z Lift Distance 8 mm 5mm 3 mm
Z Lift Speed 6 mm/s 20 mm/s 20 mm/s
Z Retract Speed 6 mm/s 20 mm/s 20 mm/s
Anti-alias 1
1.If the print object needs high accuracy, please use
group @ and modify the anti-alias level as 16 and the
image blur as 3.
2. The group @® apply to the model whose hollowed
thickness is no more than 2mm.
3. The group @® can significantly increase the print
Notice speed by cases test. To ensure the print success and print

speed, do not modify the parameters casually.

4. The group @® must work with the 3rd Gen High-
speed release film this printer provided to avoid print
failure. The film can be used to print 30000 layers.

5. The group ® only apply to Anycubic high speed resin.
6. Refer to 18-19 pages for the instructions of parameter
groups.

--The data above root in Anycubic lab, only for reference.
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Menu Directory

Home menu

Tools

Folding Lanssa... )V
) 200 Vat Cleaning

Folding Lanssa... Folding Lanssa... 1 e
¥ T \ &1 —
' S ! Clotg Monitor

Networks

Anycubic APP
Language Service
Printer Hotspot

-
o

"]
Ee # a3 5 Scan the QR code to install Anycubic App
il = Click into settings and open the device
History More Settings clog ] £l R code to connect.

Print

Print:
Switch to local/

‘USB drivefile list [

Folding Lanssa...
& 200ml
©

File Details:

Folding Lantern
Model Feature

£ Layers 2500
© Time 5h12min

& Resin 200ml

= Layer Thickness 0.05mm

Print function setting pecdvode g

________________________ o () e > (DS
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Menu Directory

Tools

Move Z:

Move Z by 0.1Tmm
- Tmm 10mm 50mm /-l mm/10mm/50mm

Move the Z axis upwards

_______________. _____________ . - L'V\i"fri ﬁ _________________
Stop moving the Z axis 5 2-axis Home Move to check the

Move the Z axis downwards " = manual leveling effect

—————————————————————————————————— onftol Check Leveling b cTTTTTTTTmTmmEmmmmmmmm e

Return to the Tools Menu

Exposure :

ERTENALE Choose an image to expose
= 3 ___J| Choose anima 92 to expose

__S_e_F_th_e__e_)_(_p_(_D_S_L{r_?_t_IT_e_ oonl 10s - 30s 405  50s Sl set the exposure time

Expolsure b Return tO the TOOl.S Menu

. Start exposure

Vat Cleaning:
Vat Cleaning
Set the exposure time
T R o€l LNE ex posure time
_ Startexposure p@ ; =3 Return to Tools Menu
Monitor:

Reset the print times

Statistics of print times

Statistics of print layers

———————————————————————————

Enable/disable X Auto Device Check - EnabIE/disable
error automatic pause [ EEE——_—G——— @ ‘auto device check

Number Of Print:

Number Of Layers:

= Return to the Tools Menu
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Menu Directory

Information

Language:

Service:

Information:

Print history |

uage
e
fistc

More Settings:

N ”"" 4|  Official Website : https://www.anycubic.com/

Language

v (D Setthe language

Official website

e Delete the record

Layers: | e - e e
Total Time:

Completion Status:

Name: Page doWn

Layers: 1 L

:;:;:w; Status: Error 404 REturn to the Info Menu

Enter into the version interface

@ Version >

Dt Turn on/off the screen sound
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Menu Directory

Version:
Printer system JEEES
System Version | Version Information
Serial number EEEEEEUTE Enter into upgrade interface
Printer ID & >l Return to the More Settings
Upgrade:
Update
Current firmware version JEEEEEE ! OTA upgrade
Latest firmware version [E=: - USB upgrade
What’s neW | Optimization
Cloud
Cloud:

WiFi connection status

WiFi connection

___________________ g Networks.
Anycubic APP

Printer Hotspot

-
o

Scan the QR code to install Anycubic App
Click into settings and open the device
QR code to connect.

Network settings:

Name of the network

__________________________ WLAN

Set server

Server Location

14



1. Turn on the printer and then wait for the auto device check. The printer
automatically checks the hardware help you shooting the troubles and
reduce the print failure. When there is an error, the printer will pop up the

error QR code. Please scan the code and follow the guide.

Auto Device Check
Force Detection

Motor Status

Number Of Print

Number Of Layers

Force Detection
Check whether the force sensor that affects the resin volume detection
and leveling detection works.

Motor connection
Check the connection of motor to ensure it works properly.

If you disable the auto device check, the printer will not automatically

check the hardware condition.

Disable auto device check

Click 2 times

15



3. Install the screen protector.

Peel off the protective film and Peel off the film @ Align locating holes and
clean the LCD screen with tool kit squeeze out air bubbles

Peel off the film @
4. Install the print platform.

|, miz

| .

7 —t
=

Push the platform onto Tighten the knob
the platform carrier

5. Choose an exposure image to test.

The white part is
exposure area

16



Preparations

6. Install the resin vat.

Put the resin vat with its feet Tighten two knobs

stuck in locating holes

7. Install Air Heat & Pure.

RV
R,
R,

o20RROVR
SAS

00T,
SR0TeR6;
SeX0TR6:
SIRTITR
SEroReRs
RIS
6863085

?,
?,

Remove the package Peel off the backing Connectto
of carbon paper from bottom the power
adhesive, and align
the positioning line to
secure Air Heat & Pure
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File Upload

USB

1. Use Anycubic Photon Workshop software to process the 3D model file.

The installer and instructions is saved in the USB drive.

2. When you set the parameters in Anycubic Photon Workshop, there are
three groups of parameter which can be apply to the print with different
needs.

Preset Printers Machine Resin

Anycubic Photon Mono M5s Pro

N | ‘ Edit Resin | [T I R E |
Name Resolution Exposure A il
DefaultResin_Normal (X)) 5
Default Resin_Fast [ 0:100mm | ,.5
High Speed Resin [ 0.:100mm | ;T-::m,us

Choose the parameter group according to the personal requirement

@ Default Resin_Normal

Apply to the Anycubic resin with normal printing speed. If the print object
needs high accuracy, please modify the anti-alias level as 16 and the
image blur as 3.

@ Default Resin_Fast

Apply to the Anycubic resin with fast printing speed. The layer thickness is

0.1Tmm. Optimizing the Z-axis motion control increases the print speed.

18



File Upload

® High Speed Resin
Only apply to the Anycubic high speed resin with the fastest printing speed.
The layer thickness is 0.1mm. Optimizing the Z-axis motion control

increases the print speed.
Notice for parameter group@0®:
1. The parameters apply to the model whose hollowed thickness is no more than
- 2mm.
2. The parameters must work with the 3rd Gen High-speed release film this

printer provided to avoid print failure. The film can be used to print 30000 layers.

3. Save the sliced file to USB drive.

4. Then, insert the USB drive to the printer.

USB drive:

@ Itis recommended that use the USB drive we provide. If you are using your
own USB drive, please ensure that it is formatted to FAT/FAT 32 and has a

. memory size of less than 32G.

(2 To ensure proper file reading, please put print files in the root directory of
. USB drive.

/
I
'
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File Upload

Cloud

Please connect the printer to Anycubic App first for remote uploading and monitoring.

1. Check whether it is global server. If not, click to switch to the global
server and wait for the printer restarting.

Server Location
= WLAN p—

Server Location

Networks
Anycubic APP

Printer Hotspot

3. Please search “Anycubic” in App Store or Goolge Play, or scan the QR
code on the printer, to download Anycubic App. Then, sign up and sign in.

4. Add a printer in Anycubic App.

Workbench < Add printer Help

Printer network is reset

B3 File > O Task > 1. Turn on the printer switch and enter the system in the
main menu of the screen

-

|

2.1n the system menu, click the Connect APP button on
the right

Help More >

Photon M3 Max FF R {FHISA ﬂ

®

Workbench Use other methTo add|

Network has been 1

20



File Upload

5. Connect to printer’s hotspot.

< Anycubic
< Settings WLAN Edit

< Add printer
Networks Disconnect

Anycubic APP c 0
WLAN
o ©

Printer Hotspot @,/ AC-A21A5F019A83 @“‘» o}
/' AC-XXXXXXXXXK =0 | SR — L ] -
MY NETWORKS B

Connect to printer's hotspot

AC-XXXHXXKXKX +0 £} Scan the QR code to insf MY NERWORKS
Click into settin vice

AC-5EEAD8059C51 =0

Please connect the printer to the following printer hotspots
AX56U a=0
Example  AC-XXXXXXXXXXXX Check the printer’s hotspot Mi10S a ®®
After successful connection, please return to this screen RT-AX86U a= 0
RT-AX86U_5G a= 0

OTHER NETWORKS

AC-AGBE1701ASDF =0
Acl a0
ANYCUBIC-guest a0
ANYCUBIC-office a0
ChinaNet-CVzw a= 0

Select the printer’s hotspot

6. Return to App, connect the printer to the network.

< Add printer Add printer

Printer hotspot connection successful

Connected: AC-A21A5F019A83
Please select the WiFi the printer needs to be connected

The printer is connecting to the network
Please stay on the current page and do not leave

WiFi list

o. ‘ b4
J
= Redmi L
Connecting16%
= office

% ANYCUBIC-guest @ Transfer WIFI information to the printer

RT-AX86U # Printer connection successful

P)

ANYCUBIC-office

Please enter WIFI hotspot password

)

ANYCUBIC-guest

)

ANYCUBIC-office

P)

js2b-wifi

P)

Act

P

ANYCUBIC-office

= OPPO . Tips: Next
The leveling of the print platform is very important. Printing the
= RT-AX86U first layer is the foundation of the entire model. The first layer is
good or bad, and directly affects the effect of the model
printing. After one leveling, later printing does not need to be
T adjusted every time.
= office

% ANYCUBIC-guest

Select WIFI Enter in password

Notice:

@ The location and local network must be allowed to use during connection.
@ Please ensure the connection to printer’s hotspot during the network
connection to avoid connection failure.



File Upload

7. Printer is added successfully. Search model or upload the model files.

e Search model

Workbench Search model

More than 1 million printable
B2 File > O Task >

& Popular searches:  alien  flexi harry potter

A deadoralive  onimask terminator v
Printer More >

Recommend Sliced Newbie zone

Anycubic Photon Mono M5s Pro
 Availabl

Total printing time: 0 hour 0 min

Total consumption Resin: Oml

Printer type: Anycubic Photon Mono MSs Pro

AN
.
: tortoise Free 3D print Gridfinity Pick + Tweezer
model recommendation CChange el Racks
Catrader Thangs

P il

o

=2}

Batman on a roof CATBUS(MY NEI..  Cobb Vanth
Early summer Early summer Early sum|
Help More > Ironman helmet with Succubus
opening mechanism Thangs
3 . 3 o
© Q © 7] Q
Workbench Search model

* Upload the modelfiles

Workbench < File Space use0.008/2.0068
B F > O Task >
Printer More:>
There are currently no printable files, Please upload model or
slice files
Anycubic Photon Mono M5s Pro
® Availab
Total printing time: 0 hour O min
printer model recommendation C Change

Total consumption Resin: Oml

Printer type: Anycubic Photon Mono MSs Pro
Batman on a roof

model recommendation CChange @ «yle white

CATBUS(MY NEIGHBOR TOTORO)

B Daniel Toledo

Cobb Vanth from Star Wars the

FER=SSM | andalorian
Batmanonaroof  CATBUS(MY NEL.  Cobb Vanth 'k%x\
- ¢ @ Harry Owvera

Early summer Early summer Early sum|
> Chained One
Help More >
. ] @ Harry Olvera
©
Workbench .

22



File Upload

Cloud Connection Troubleshooting

Issues Troubleshooting Solution

Check whether it is
printer's hotspot

Fail to connect to
printer's hotspot in

App

If not, please reconnect to
the printer's hotspot.

If not, please click @ in
Cloud menu on the printer to
reset WIFI. Then, connect the
printer to network again.

Check whether the WIFI
and its password is
correct

The printer prompts | Check whether WLAN
that WiFi on printer is the WIFI
connection failed )

If not, please click . in
Cloud menu on the printer to
reset WIFI. Then, connect the
printer to network again.

Join an available network.
Click @ in Cloud menu on
the printer to reset WIFI. Then,
connect the printer to
network again.

Check whether the WIFI
network is unavailable

Connection Status

WiFi module off WiFi module on WiFi module on
disconnected disconnected connected

23



Print Test

Resin Preparations

*The release film on the resin vat is consumable. Please pay attention to the
status of release film on the touch screen and replace the film timely.

Please check the release film carefully before and after every printing. If the film
is broken, replace it immediately to avoid further damage to the machine.

1. Slowly pour resin into the vat with resin level not exceeding the vat’s

ﬁ Mﬁ;
| !

2. When the ambient temperature is below 20 °C, it may cause the

maximum scale.

-
g

detachment of printed bottom or partial loss of printed objects. At this time,
you can use Air Heat & Pure to raise the printer’'s ambient temperature to

improve the printing effect.

() Turn on Air Heat & Pure.

(- @ (. 5@ (. @

ANYCUBIEC ANYCUBIEC ANYCUBIEC
[138]*° [o40]* [138]*
@ ® 006 ® @ @@ ® @\@ ®
AirHeat & Pure A.,Heal — — | {mre
Start heating Set the temperature Start air purification
(Recommended =35°C) (optional)

()4

|| il

Put on the cover

24



Print Test

(2 Enable the delay start and set the waiting time. The printing will start

when the countdown is over. The delay start is disabled by default.

Please refer the waiting time as followed:

Ambient temperature Delay start
5~10 °C 60 min
10~25 °C 30 min

- Notice: High speed mode (sliced file) requires high speed resin! Otherwise, the
print may fail.

25



Print Test

Print File

Print USB drive file

Folding Lanssa... Folding Lanssa...

Folding Lantern
Model Feature

& 100

© 4t

= Nor

200ml

% Folding Lanssa... Folding Lanssa... )
& 2201 a & 120m|

B © 3hsc b © 6hiomir
& Spec & Speed

Print Function

Remote print

Workbench < Print Online slicing
Cloud Local
B File > O Task >
Printer: Anycubic Photon Mono M5s Pro
Printer More > TEST .stl

Type: model file

5] size: 54.35MB

Anycubic Photon Mono M5s Pro
® Avs

2022-03-25 10:00:00

Total printing time: O hour 0 min 23 Prig
Total consumption Resin: Oml

Printer type: Anycubic Photon Mono M5s Pro

TEST .stl
.
Type: model file
model recommendation CChange 55 Size: 54.35MB
&

2022-03-25 10:00:00

Al

& Print

& 11.11¥22.22+33.33mm

Batmanonaroof ~ CATBUS(MYNEL.  Cobb Vanth @ Anycubic Photon Mono MSs Pro
Early summer Early summer Early sum|
Slicing template
Help More > | precision first v Speed first

{

®

Workbench

Start p?o‘g

26



Print Test

Before printing

1. The printer checks the hardware condition, resin volume and leveling
before each print job. When there is an error, the printer will pop up the

error QR code. Please scan the code and follow the guide.

Waiting Time

If the delay start is enabled, the printing will start when the countdown is over.
Resin

(D Check whether the volume of resin in the vat is sufficient to finish the print
job. Usually, the required resin volume is a little more than the resin volume
estimated by the slice software. If it prompts that the resin volume is not
enough, please add resin and then check it again.

(@ Check if there are solid residues of more than 3mm in the vat. If residues are
detected, please clean the vat and check again.

Leveling

Check the leveling to avoid layer separation or other errors.

2. If the delay start is enabled, you can choose to skip the countdown if
necessary. Please be cautious, as low ambient temperature and insufficient

heating time may lead to print failure.

27



Print Test

In Printing

Error Auto Pausing: During printing, the printer automatically monitors the
conditions which may cause print failure and prompt the error to the
customers in case resin is wasted or even damage the printer. When the
printer detects an abnormal condition, it will pause the print job
automatically and pop up the error report. Please check the sliced file and

the model according to the report.

Bottom non-stick detection

It monitors the condition that model does not stick to the print platform.

When the printer detect the model does not stick the platform, please check the
bottom exposure time of the file.

Intelligent Release: The function can improve the printing success rate by
optimizing algorithm. Enabling intelligent release while printing with the
default resin_normal parameter group can also increase printing speed.

The function is enabled by default.

The function you don’t need can be disabled before printing.

28



Print Test

After Printing

1. When the printing is finished, resin may be cured partly in the vat. Please
set to Vat Cleaning and remove the residue.

Remove resin sheet
by plastic scraper

2. Finishing

« After printing, remove the platform when resin stop dropping from the
platform. Remove the model by metal scraper and then wash it with 95%
alcohol or other detergent. It may need post-curing to achieve better
hardness by being exposed directly to sunlight or a UV-curing machine.

+ After printing, there might be some cured resin left in the vat. Please
clean the vat timely, and filter the remaining resin by a funnel. Otherwise,
it may cause damage to the release film or LCD screen. If you do not use
the resin now, it is recommended to store it in an airtight container away

from light.

2 |
//9/ Vat spout—

7 ]Z i’,;;‘}f;‘—Funnel
I\
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Resin Exposure Range Finder

“R_E_R_F" is an abbreviation for “Resin Exposure Range Finder”. This function

is used to find out the optimal exposure parameters for different resins.

1. Import the R_E R F file which is saved on USB drive into the slicing
software. There are eight models in the file. The exposure time for model 1
is equal to "normal exposure time (s)" of the file, and the exposure time for

other models will be increased by an increment of 0.25 s.

The numbers on the models indicate their order

2. According to the personal requirement, adjust the exposure time of the
models by modifying "normal exposure time (s)” of the file. When exposure
time for Model No. 1 is changed, the exposure time for other models will be

increased by an increment of 0.25 s.

For example, when normal exposure time is set to 1.5 s, the exposure time
for Model No.1-8is:1.5/1.75/2/2.25/2.5/2.75/ 3/ 3.25 s.

3. After printing, remove and clean the models. Compare the print effect of
models and choose the model’s exposure time that meets your needs as

the print parameter. Take a comparison of model A&B as an example.

30



Resin Exposure Range Finder

e oy More cylinder

« Model A has more holes and fewer cylinder. If you print by the parameter
of model A, more details of model can be printed with high risk of failure.
« Model B has fewer holes and more cylinder. If you print by the parameter

of model B, model may be printed successfully yet with some details lost.

In addition, you can compare the bridges, needles or other parts to choose
a proper model and find the parameter. If none of them can be chose,

adjusting the "normal exposure time (s)" is suggested.
Notice: DO NOT change the file name of “R_E_R_F"”, because Anycubic 3D printer

can only recognize THIS file name to run this function. Also, do not name other
fileas “R_E_R_F".
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Maintenance

Leveling

The printer has been designed requiring no
leveling for the first use. However, please re-
level the printer in the following scenarios:

* The print platform has been fallen to the

ground.
Scan the QR code for

» Changing new print platform or LCD screen. _ _
the leveling tutorial

» The printed object sticks to the resin vat

instead of the print platform.

Please follow the steps below to install and re-level.

1. Install the print platform.

Loosen the four Push the platform onto Tighten the knob
leveling screws the platform carrier
2. Leveling.

A I 1 38 4R

Leveling Paper

1= 1=)

Place the leveling Click “Z-axis Home" Lower Z axis by Tmm
paper (included)
on the LCD screen

32



Maintenance

) =
e d e
N
— .

If the print platform Lower until there is resistance
shakes with light press, when pulling out the leveling
lower Z axis by paper, hold the platform and

0.1mm each time tighten the four screws

3. Check whether the leveling is successful. If it does not match the result

shown below, please loosen the four leveling screws and follow the step2

to re-level .

-
Ehe:k ) S

Click “Check Leveling” There is a significant
resistance when you

pull the leveling paper

33



Maintenance

Resin Vat Maintenance
* Remove the cured resin from release film: Set Vat Cleaning and then

remove the cured resin sheet to protect the film. Do not use sharp objects

to scrape off the residues on the film.

Remove resin sheet
by plastic scraper

* Release film replacement: The statistics of print times and print layers

are shown in Monitor interface. Please check them and replace release

film timely to avoid print failure or even the damage to printer.

Replace release film Click reset button
at this time after replacement

» If you do not use the resin for over two days, store it in an airtight

container away from light.

Firmware Upgrade
Check whether the current firmware needs update. “Optimization” shows

what'’s new in the latest firmware.
» USB upgrade: Visit the official website to download the installer and
save it to a USB drive. Then, insert the USB drive to printer to upgrade.

* OTA upgrade: If the network is connected, directly upgrade by OTA.

OTA / USB upgrade

34



Maintenance

Z-axis Maintenance

If Z axis makes a noisy sound, please apply lubricant to Z lead screw.

S

Cleaning

* Clean the print platform: Clean platform with alcohol and paper towel.
* Protect LCD screen : If the resin cured on screen protector, please
replace it immediately to protect LCD screen.

» Clean the body of printer: Clean the body of the printer with alcohol.

Activated Carbon

» Service life: The activated carbon filter can be used for 3~6 months.
* Reuse: Expose the used carbon to the sun or a well-ventilated place to

dissipate the odor until the carbon is replaced.
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Model do not stick to platform

Bottom exposure time is insufficient. Please increase the exposure time.

Contact area between the model and platform is small. Please add a raft.

Layer separation or splitting

The machine is not stable during printing.

The release film is not tight enough or needs a replacement.
The printing platform or resin vat is not tightened.

The lift speed is too fast.

The model is hollowed without punching.

Layer shift

Add supports.
Reduce the lift speed.

Floccules left in resin vat or attached to models

The exposure time is too long. Reduce the normal exposure time and

bottom exposure time.

Thank you for purchasing Anycubic products! Under normal usage and
service, the products have a warranty period of up to one year. Please visit
Anycubic support center(support.anycubic.com/en) to report any issues
with Anycubic products. Our professional after-sale service team would
respond within 24 hours and solve the issues.
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